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Overview
The Velocity 3.5 SP2 release includes many bug fixes, several new features, and support for a video integration plug-in for the
American Dynamics Intellex DVR and VideoEdge NVR.
For more information, see the tables of New Features and Enhancements and Bug Fixes.
This document also summarizes the Known Issues in this release.
•

To utilize all the features of 3.5 SP2 (including support for the Mx controller which was added in 3.5 SP1) requires CCM
version 7.5.04 or later. We recommend that you use the latest version, which is currently 7.5.08.

•

To utilize the PIV-I/128-bit GUID support (first provided in CCM Version 7.4.58) also requires MATCH2 version 130127 or
later. (ScramblePad model numbers starting with DS47L-SSP include a MATCH2 board.)

New Features and Enhancements
Reference ID

Feature

Description

VEL-249

Option to show or hide
the bubble text of alarms
in Graphics

When an alarm occurs on a point that is plotted in Graphics, the alarm’s descriptive
message is displayed as “bubble text” next to the point’s icon. This bubble text can
cover up nearby icons for other points, which can be as issue when there are multiple
active alarms.
A new option has been added to Graphics, so you can decide whether or not to show
the bubble text of alarm information. This Show Alarm Info Bubble Text option is
located on the General tab of the Graphics Options dialog:
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VEL-1671

Operators who have the
permission to add an
object can now also use it

Previously, operators who were not a member of the Administrator role but had the
permission to add certain types of objects were unable to use an object they had
created, until an Administrator manually granted them permission to use that new
object. Now when an operator adds a new object, the permission to use that object is
automatically granted to all the roles that the operator belongs to which have
permission to add that type of object.
This means that a non-admin operator can now create and use these objects:
Command sets, Credential templates, Door Groups, DVRs, Function Groups,
Graphics, Master Door Groups, Person Groups, Person templates, Status Viewer
Groups, and Video Explorer Groups.
NOTE: This change does not apply to Time Zones or Master Time Zones.

VEL-3051

Add Sync Credentials
functionality

A “ghost credential” is a credential which exists in a controller’s memory but not in
Velocity’s SQL database. If someone uses a ghost credential to gain access, Velocity
doesn’t know who was just granted access.
Now Velocity automatically synchronizes the credentials in its database and in a
controller, by deleting any unused/ghost credentials when you download credentials
to that controller. Then if someone tries to use a ghost credential again, the controller
will report that credential as unknown and deny access.

VEL-3075

Email Writer reliability
enhancements

Previously, the Email Writer extension service would stop working after it received a
total of 10 errors, regardless of whether successful attempts were made between
those errors. The behavior of the Email Writer has been improved so that:
• The error count is reset whenever there is a success.
• For each failure, a software event #1284 is generated to let you know that an email
was not generated.
• When 10 consecutive failures occur, an alarm #5911 is generated to let you know
that the Email Writer is no longer processing requests.

VEL-3097

Enhance SNIB2 network
communication tolerance

When there is a momentary break in the communication between Velocity and a
controller with a SNIB2 board, the polling engine tries to recover by taking the port
offline and then immediately reconnecting. This can result in an operator seeing a
sporadic port offline alarm quickly followed by a port online event, which is a problem
at very secure sites that must thoroughly respond to every alarm.
A new option (which is turned off by default) enables you to have Velocity suppress
the generation of an offline alarm when the corresponding online message occurs
within a specified number of seconds. This is an advanced feature that is not
exposed in Velocity’s user interface, contact Sales Engineering for more information.

VEL-3193

Include biometric data in
Velocity’s Data Export

Previously, biometric data was not included in the information generated by Velocity’s
Data Export feature. Now biometric data is included in the exported information.

VEL-3203

Add configuration to allow
the DTServer to continue
to poll and log
transactions after an
SDServer disconnect

Previously, when the DTServer lost its connection with the SDServer, it stopped
polling for transactions from the controllers. This was a problem at large sites with
hundreds of controllers, which had to wait for several minutes while the DTServer was
restarted.
Now the DTServer has an option (which is turned off by default) to continue to poll
and log transactions after losing its connection with the SDServer. This is an
advanced feature that is not exposed in Velocity’s user interface, contact Sales
Engineering for more information.
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VEL-3218

Add VelocityDebug
configuration options to
allow DTServer and
SDServer to rotate logs
based on size as well as
add configuration to write
logs to separate directory

VelocityDebug.ini (which is used to configure the debug logging for several of
Velocity’s components) has some new common properties that enable you to better
manage the debug log files. These new properties supercede the previous
NumberOfDaysToKeep property.
• StartupMode={0,1} where 0=Rotate the log files at each startup (by renaming .TXT
files to .BAK files, starting new log files, and rotating them whenever one reaches
the specified RotateBySizeMB value), and 1=always append data to the current log
file. (The default value of this option is 0.)
• LogDirectory= the full path of the service log file location. By default, log files are
created in the Velocity application path (which is typically C:\Program Files\Hirsch
Electronics\Velocity).
• RotateBySizeMB=N where N is the maximum size in MB of a log file before it is
rotated. (If this option is not specified, the default value is 500 MB.)

VEL-3256

Add PDF option for the
output format of an Email
Reports scheduled task

Previously, scheduled reports sent via email could only be generated in HTML format.
Now the scheduled reports can be generated in either HTML or PDF format. (In
Velocity’s Scheduler, select the task type of Email Reports, and choose the desired
output format.)

VEL-3294

Add new scheduled task
to Synchronize Controller
Clocks

Synchronizing the time on the Velocity Server and controllers is especially important
for sites using a video integration. To help automate this task, Velocity now has a
default scheduled task to Synchronize Controller Clocks at 2:30 AM every night.

VEL-3312

Implement SQLWriter
service to offload
database logging from
SDServer

Velocity now has a SQL Writer service that offloads the database logging tasks which
were previously part of the work performed by the Velocity Security Domain Service.
This SQL Writer service is one of Velocity’s basic required services (along with the
Security Domain Service and the DIGI*TRAC Network Service).
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VEL-3317

Add option in Enrollment
Manager to enable
enhanced PIN security

An option has been added to the Enrollment Manager’s Preferences dialog to Enable
enhanced PIN security. When this option is checked, a PIN code must have at least
four digits and cannot contain either three adjacent repeated digits (such as 777) or
three consecutive digits (such as 123).
PIN codes such as these are considered less secure because they are frequently
chosen by users who want an easy to remember number, so they are more likely to
be used by someone trying to gain access by guessing a PIN code.

VEL-3328

Allow adding operator to
user-specified domain if
the "Custom Velocity
Users Group Names"
option is enabled

Velocity has a “Custom Velocity Users Group Names” option (on the Advanced page
of the Velocity Settings dialog) which is only available when your Velocity Server is
part of an Active Directory domain. If that option is checked, the General tab of the
properties dialog for adding a new operator includes a Domain field which might have
a drop-down list of values.
For sites that have a complex Active Directory trust structure, the Domain field now
enables you to type in the necessary value if it is not present in the drop-down list.

VEL-3351

Executive Override
Reports

The set of standard reports in Velocity’s Report Manager now includes:
• Executive Override Passback, which a list of all credentials where the Executive
Override option (on the Options tab of the credential’s Properties dialog) is checked
for the Anti-Passback feature.
• Executive Override Passback with UDF 123, which is a list of all credentials
where the Executive Override option (on the Options tab of the credential’s
Properties dialog) is checked for the Anti-Passback feature. This report includes up
to three user-defined fields.
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VEL-3352

A/B Rule Reports

The set of standard reports in Velocity’s Report Manager now includes:
• A-B Rule Status Report, which a list of all credentials that have been assigned an
A/B rule (for the 2-person rule).
• A-B Rule Status Report with UDF 123, which is a list of all credentials that have
been assigned an A/B rule (for the 2-person rule). This report includes up to three
user-defined fields.

VEL-3367

Option to show server
name in status bar of
Velocity’s main window

A new option (which is turned off by default) enables you to include the name of your
Velocity Server in the status bar of Velocity’s main window, to the left of the date/time
field. For example:

This option is not exposed in Velocity’s user interface, contact Sales Engineering for
more information.
VEL-3374

Customization of the
ribbon toolbar and system
menu in Velocity’s main
window

Most of Velocity’s user interface can be modified using the Customization Manager
tool. However, the ribbon toolbar and system menu of Velocity’s main window are
implemented using features supplied with Microsoft Windows, so they must be
modified separately. For detailed instructions, see the following topics in Velocity’s
online help system:
• Velocity Basics ▶ Changing the Language Used on Velocity's Ribbon Toolbar and
System Menu
• Velocity Basics ▶ Customizing Velocity's Ribbon Toolbar
• Velocity Basics ▶ Customizing Velocity's System Menu

VEL-3426

Improvements to
downloads and the
Download Monitor

Various improvements were made to Velocity’s Download Monitor (and related
processes) to solve the following issues:
• When a custom global passback service caused a deadlock on the Commandsets
table, incorrect information was recorded. (Now when this deadlock occurs, the
operation is retried twice.)
• When downloading a door group to a controller that is disabled, the transaction sets
were not automatically executed after the controller was enabled and came back
online.
• When downloading multiple holidays, a separate batch was created for each
holiday. (Now the downloading of multiple holidays is optimized so there is only
one batch per controller.)
• Some download operations were leaving orphaned rows in the database, which
caused some tables to grow larger over time. (These problems have been
corrected.)
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Bug Fixes
Reference ID

Bug

Description

VEL-216

Add-Ins Help
button in Server
Extension
Properties does
not work

The Help button on the Velocity Server Extensions Manager window was not working.

In Graphics,
immediately
accessing a door
while a door is
forced will not
activate the relay
as expected

In Graphics, a door sometimes would not open after an operator right-clicked on the door’s
icon and chose an access function. (This issue happened the first time an alarm occurred
for a Velocity object, and the menu item key was improperly reset when Graphics generated
the alarm’s “bubble text”.)

Escalated alarm
doesn't appear
in Alarm Viewer
until refreshed

Escalated alarms were not appearing automatically in the Alarm Viewer after their specified
escalation interval. (They were displayed after the operator manually refreshed the Alarm
Viewer.)

DigiTrac service
starts but does not
communicate with
panels

Velocity’s DIGI*TRAC Network Service sometimes would not communicate with controllers
when tasks were scheduled to run more than once a day, if the next scheduled time
occurred on the following day.

Velocity fails to
install on drives
that come preformatted by DELL
computers

Velocity was not installing properly on computers where the hard drive did not support the
old DOS-style 8.3 filenames.

VEL-287

VEL-1796

VEL-2860

VEL-2877

VEL-2971

VEL-3009

VEL-3043

This issue has been fixed, so that this Help button now opens the “Client Add-Ins and Server
Extensions ▶ Server Extensions ▶ Server Extensions – Introduction” topic in Velocity’s help
system.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed, by having the Velocity Installer no longer require support for 8.3
filenames.

Error occurs if
closing Print
Preview screen
after closing
Credential
Properties screen

If you had the Properties dialog and the Print Preview window open on the same credential,
and then closed the Properties dialog, an error would occur when you closed the Print
Preview window.

Error occurs when
deleting the port
from either the
Server or Client

If you deleted something (such as a port) from the hardware tree in Velocity’s Administration
window, an error could occur.

Velocity Installer
allows IP address
in Server name
field

During the installation of a Velocity Client, the Velocity Server location field (on the Install
Options screen) enables you to bypass the drop-down list and the browse button methods of
selecting the server by manually typing in a server name, IP address, or fully-qualified
domain name. However, an IP address or fully-qualified domain name was not being
converted to the necessary server name format.

This issue has been fixed, by requiring you to close the Print Preview window first.

This issue has been fixed.

This issue has been fixed.
VEL-3080

Link Credential
expiration to UDF

When a credential template was changed, the credentials using that template were not being
deactivated or expired on the scheduled date specified in a user-defined field.
This issue has been fixed.
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VEL-3098

An Admin using
group view or nonAdmin without
permission to
Administration
window will get an
application error
when controller is
added on another
client

An error could occur when a controller was added in the Administration window on a
different Velocity Client, if either an Administrator was using the Group Types view in the
System Tree pane of the Administration window, or a non-Admin operator did not have the
role permission to use the Administration window.

VEL-3099

This issue has been fixed.

Deleting points
Deleting certain types of points in Velocity’s Administration window did not delete the
plotted in Graphics corresponding plotted points in Graphics. The types of points affected were:
does not delete the
• Dialup location
points
• CCTV port, CCTV switcher, and CCTV camera
• Alarm receiver, Account, Area, and Point
This issue has been fixed.

VEL-3101

VEL-3103

If an XBox (XNet)
or port (SNet) has
the same name as
the controller you
are trying to move
the controller will
not move to it

This issue has been fixed.

Badge Designer
should not launch
if the operator
does not have
permission

Role permissions for the Badge Designer tool and the Graphics tool were somewhat
confusing and did not always work as intended. For example, an operator without the
necessary role permissions to use the Badge Designer could still open that tool instead of
receiving an access denied message (even though he was then correctly prevented from
making any changes).

If a controller had the same name as the XBox (for the XNET protocol) or the port (for the
SNET protocol) you were trying to move it to, it could not be moved there.

The role permissions have been changed so that:
• The top-level role permissions folder formerly named Graphics has been renamed to
Graphics/Badges.
• Under Application Permissions ▶ Badges, a new role permission of Badges – Use has
been added. (This role permission is examined whenever an operator clicks on the Badge
Designer icon on the ribbon toolbar of Velocity’s main window, or tries to switch to Badge
mode in the Graphics tool.)
VEL-3107

VEL-3112

Server Disconnect
message is hidden
behind Graphics
window on client

Error occurs when
clicking on Quick
Link Viewer after
selecting a blank
field in Custom
field in Properties

When a Velocity client disconnects from the server, the message dialog can be hidden
behind the Graphics window. This can be a problem when the Graphics tool is running in
full-screen mode.
To make the message dialog visible, the Graphics window will automatically be minimized
when the Velocity client disconnects from the server.
In the Graphics tool, an error would occur if you clicked a Quick Link Viewer object after you
had selected the Custom field in its Properties sheet but left that field blank. After the error
occurred, that Quick Link Viewer object could not be deleted.
This issue has been fixed.
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VEL-3115

Trigger Action
Manager does not
update Address
change when
controller is
dragged from Snet
to Xnet Port

When a controller with programmed Trigger-Action pairs was moved to a different port, the
Trigger-Action pairs retained their previous port address (instead of automatically being
updated).

Clicking in Layer
field after the
address is
changed in
Graphics, causes
the icon on canvas
to become invisible
in live mode

In Graphics, the icon for some objects could become invisible in Live mode after you clicked
in the Layer field on the object’s Properties sheet. This could occur with an object that has
the Visible property or an Address.

Clicking on left
mouse button after
the address is
changed in
Graphics, causes
an error in live
mode

In Graphics, an error could occur in Live mode if you changed the address of a point and
then clicked on the Left Mouse Click drop-down list on the point’s Properties sheet.

VEL-3120

VEL-3122

VEL-3151

VEL-3156

VEL-3159

VEL-3168

VEL-3171

VEL-3183

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

No warning issued
when the data for
a UDF field in
Person Template
is invalid

In certain situations, invalid data could exist for a credential. For example, when a userdefined field which originally contained text was changed to a Unique Number, the UDF
validation checking did not detect the invalid data.

Lock down
functionality does
not work if the
Workstation Name
contains an
apostrophe

If a workstation’s name contained an apostrophe character, that workstation could not be
locked down.

Renaming an
imported controller
causes an error on
other clients and
server

Renaming an imported controller caused an error on the Velocity server and on other clients,
but not on the client where the controller was renamed.

Help button in
Point Monitoring
Zone window does
not open the Help
window

The Help button on the Point Monitoring Zone window was not working.

Changing
properties in an
imported controller
causes an app
error

Changing the properties of an imported controller caused an error on the Velocity server and
on other clients, but not on the client where the controller’s properties were changed.

Multiple selection
problem in Alarm
Notes

The queue for adding operator notes to multiple alarms was not being cleared if you
cancelled adding the notes and then selected a different set of alarms to add operator notes
to.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed, so that this Help button now opens the “Badge & Graphic
Designer ▶ Drawing and Designing ▶ Drawing a Control Zone” topic in Velocity's help
system.

This issue has been fixed.

This issue has been fixed.
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VEL-3190

All door controllers
(M2, Mx2, Mx4)
display 8 doors
when in Group
Type View in the
Administration
Window

When the Group Types view was selected for the System Tree pane of Velocity’s
Administration window, every controller was displaying 8 doors (even if a controller actually
supported only 2 or 4 doors).

Graphics right
clicking to change
state may not
always happen the
1st time

In Graphics, right-clicking on an object and selecting a command from the pop-up menu
sometimes did not appear to work, because a different object nearby was accidentally
selected while navigating the multi-level pop-up menu, so the command was performed on
that object (instead of the intended object).

Creating a Serial
CCTV Port while in
the "Group Type
View" changes to
TCP\IP when you
look at its
properties

When the Group Types view was selected for the System Tree pane of Velocity’s
Administration window:

VEL-3198 and
VEL-3199

VEL-3205

This issue has been fixed.

This issue has been fixed.

• The Interfaces Configuration ▶ CCTV folder did not show any CCTV ports (regardless
of whether they were serial or TCP/IP).
• The Properties dialog of a serial CCTV port incorrectly indicated that it was a TCP/IP port.
These issues have been fixed.

VEL-3206

Person Summary
Reports containing
the UDF pick list
does not sort the
UDFs

In Report Manager, some of the standard reports enable you to include the data from up to
three user-defined fields, which you select from drop-down lists. The contents of those dropdown lists were not being sorted in FieldNo order.
This issue has been fixed.
NOTE: Report Manager remembers which user-defined fields you selected for a report. For
example, if you run a report which includes user-defined fields and you select UDFs 2, 4,
and 6, those UDFs will be the default selections the next time you open that report’s criteria.

VEL-3213

VEL-3215

Status Viewer
reports the
controller as online
but if you try to
send a command
to it (e.g., trigger a
door) you get an
"execution failed
controller offline"
event

The Status Viewer was not always showing the current status of a controller.

Mx controller with
default System
Code will still allow
keypad
programming

When support for the Mx controller was added to Velocity, the option for enabling or
disabling keypad programming was removed from the Properties dialog of a reader
connected to an Mx controller. However, the options to Disable local keypad
programming and to Enable local system code reset were not disabled on the Setup
page of an Mx controller’s Properties dialog. In certain situations, it was possible to enable
keypad programming at the readers connected to an Mx controller and not have a user
interface in Velocity to disable that feature.

This issue has been fixed.

This issue has been fixed, so that:
• For both DIGI*TRAC and Mx controllers, by default keypad programming and resetting the
system code are now disabled.
• For Mx controllers, those two options are greyed out so they cannot be changed, and the
default system code has been changed to 00000000.
VEL-3237

Velocity 3.5 Data
Exchange - PIV
Credential Fails

A customer was initially unable to import a file of user data which included MATCH or card
data, when specifying a template that directed the import to build the MATCH code from
some user-defined fields. To resolve this conflict and enable the import to succeed,
whenever the necessary data was available in the user-defined fields, a new MATCH code
was generated and it replaced the previous value.
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VEL-3246

SDServer stops
logging events to
the database
without any
notification of an
error

A customer had an issue where some events were not being recorded in Velocity’s
database.

Port Properties
Ping Button
flashes CMD
Window for an
instant but you
can't see it

After clicking the Ping button on the Properties dialog of a TCP/IP port, the resulting
command line window was displayed so briefly that you did not have enough time to read
the information.

Computer with no
Serial Ports
causes infinite
exceptions in
DTServer

On a computer without any serial ports, an exception was being continuously logged in the
DTServer log file.

Certain sites are
unable to install
Velocity using
Advanced
Authentication
(Custom Groups)

A customer was unable to install Velocity using custom users/groups on a domain with
Active Directory Organization Units.

Right Click on
Event Viewer will
display incorrect
credential if
windows scrolls
before menu item
is selected

In the Event Viewer, right-clicking on an event for a credential and selecting the Display
Credential command from the pop-up menu did not work when the Event Viewer’s content
was scrolling, because a different event was accidentally selected while navigating the multilevel pop-up menu.

Canvas Tab inside
the graphics get
the wrong
character set

On a Velocity client that used the Czech language, the Canvas tab names in the Graphics
tool were displayed in a different language.

Velocity Technical
Support File and
Velocity Threading
Queue-Technical
Support File don't
reset on service
restart

Some Technical Support log files could grow to a very large size and have to be manually
renamed so additional information could continue to be gathered, because the files were not
automatically reset after a service restart.

Error occurs if two
identical Hirsch
Video Integration
Trigger Actions
exist

If two identical trigger-action pairs existed in a plug-in for the Hirsch Video Integration, a
Velocity Alarm Viewer error could occur.

Aventura Plugin
Update gets
removed from the
SQL Velocity
Database after
uninstalling Hirsch
Identive Update for
Aventura Plugin on
a client

After uninstalling an update to the Aventura plug-in (for the Hirsch Video Integration) on a
Velocity client, the update was also removed from Velocity’s database, which meant it would
have to be reinstalled on the Velocity Server.

VEL-3247

VEL-3248

VEL-3249

VEL-3251

VEL-3254

VEL-3255

VEL-3264

VEL-3270

This issue has been fixed, and an alarm event is generated if there is an error logging events
to the database.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.
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VEL-3271

Cancelling an
Aventura update
doesn't try to install
it again the next
time you launch
Velocity, and Help
About shows the
build that was
cancelled

After cancelling an update to the Aventura plug-in (for the Hirsch Video Integration) on a
Velocity client, the update did not automatically try to install itself the next time Velocity was
started, and the Help ▶ About command showed the version number of the update that
was cancelled.

Right Click
functions on
credential will not
highlight when you
mouse over
options

In Enrollment Manager, after you selected a person and right-clicked on a credential, the
items on the pop-up menu were not being highlighted when you moved the mouse over
them.

Use a heartbeat
mechanism
instead of TCP/IP
ping for the keep
alive process in
the clients

Previously, the “keep alive” mechanism for checking the connection between a Velocity
client and the server relied on TCP/IP pings, which could be blocked or dropped by some
network routers or switches.

Alarm Actions
disappear after
upgrading from
v3.1 to v3.5 if
switching controller
model from M8 to
Mx8

After upgrading from Velocity 3.1 to Velocity 3.5 and switching the controller’s Model
property from M8 to Mx8, the Alarm Actions tab of the controller’s Properties dialog did not
contain any of the previously defined alarm actions.

VEL-3273

VEL-3276

VEL-3277

This issue has been fixed.

This issue has been fixed.

This issue has been fixed, by changing to a “heartbeat” mechanism.

This issue has been fixed.

VEL-3280

In Graphics, linking In Graphics, linking a VSO to a Command Set object caused an error.
a VSO to a
This issue has been fixed.
Command Set
causes an
application error

VEL-3293

End of year
rollover date-time
problem

In some situations where the Velocity Server and a controller are located in different time
zones, the event information at the end-of-year rollover could report the wrong year.

Event Viewer error
when Event Filter
deleted

When an operator who had previously selected a filter in the Event Viewer later launches the
Event Viewer after a different operator has deleted that filter, a “subscript out of range” error
was generated for every event. This required the operator to click OK in every message
dialog, and then select either a new filter or <None>.

VEL-3295

This issue has been fixed.

This issue has been fixed by sending a message to every active Velocity client when a filter
is deleted so they can set their filter to <None>, and by having every Velocity client set its
filter to <None> when it tries to use a filter which no longer exists.
VEL-3297

Selecting the Print
Badge on the
Enrollment
Manager puts
Enrollment
Manager and
Velocity in a state
where they cannot
be closed

In Enrollment Manager, when you printed a badge you could not close Enrollment Manager
or Velocity until printing was finished.
This issue has been fixed.
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VEL-3305

SDServer
exception
executing
command sets

The SDServer generated an exception while executing a customer’s particular command
set.

Change text for
Event 7030,
Persistent SNET
communication
error on SNIB2

The text for event #7030 did not accurately describe the communication error that had
occurred.

Error changing
Door Group
referenced by a lot
of Master Door
Groups

A customer received an application error when adding a card reader to a large door group
(that was part of many master door groups).

VEL-3306

VEL-3318

VEL-3321

VEL-3338

VEL-3350

VEL-3361

VEL-3372

VEL-3379

This issue has been fixed.

This issue has been fixed by changing the text from “Persistent SNET communication error”
to “Controller communication error”.

This issue has been fixed.

Adding Velocity
Data Export to
Scheduling Agent
causes Server to
close Velocity
application

Adding an Export Data task in the Scheduling Agent caused the Velocity Server to close the
Velocity client. (Although there was no error message displayed in Velocity, an error could
be displayed using the Windows Event Viewer.)

Uninstalling the
video framework
from a client
should not touch
the database

The Hirsch Video Integration – Video Explorer tool was being deleted from the ribbon
toolbar in Velocity’s main window when a plug-in to the video integration was uninstalled
from a Velocity client, but the plug-in was still installed on the Velocity server.

Custom Role
Application
Permission for
Alarm Viewer not
applying properly

Even when an operator did not have the role permissions required to acknowledge or clear
multiple alarms in the Alarm Viewer, it was still possible to do so (by including the space
beneath the last alarm in the Unacknowledged Alarms pane when using the mouse to select
multiple alarms).

App error may
occur when
opening door
component if more
than 254 badge
templates are
defined

At a site with more than 254 badge templates, an error would be generated when the Auto
Display Credentials feature tried to display information about the person accessing a door.

When deleting any
Status Group,
Error Number 381
occurred

When deleting a Status Group (on the Status Groups page of the Status Viewer Properties
dialog), an error could occur.

Velocity Installer
Admin checking
fails on German
OS

The Velocity Installer was not properly checking for administrative privileges on non-English
versions of Windows. To address this issue, the checking process has been improved, and
there is a new command switch (-a) you can specify to have the Installer bypass the
checking for administrative privileges.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

To ensure that the Installer can identify the Domain Admins group when the group has been
renamed or is not in English, you can specify the correct name to use by adding an entry to
the Bootstrap section of the Setup.config file located on the DVD. For example, on a
German computer you would add the following line:
DomainAdminGroup=Domänen-Admins

Page 12 of 18

Reference ID

Bug

Description

VEL-3380

Velocity updater
not reporting
(some) script
errors

The Velocity Updater was not reporting some script errors (such as duplicate key errors),
which could give the false illusion that the update had succeeded.

S2EDataPath
Registry
(Windows) key get
deleted during 3.5
Upgrade

Velocity 3.1 includes an option to send the SNIB2 encryption keys to a particular path, which
is specified in a Windows Registry key named S2EDataPath. But during an upgrade to
Velocity 3.5, that registry key was being deleted, which broke encryption on all controllers
(because the Velocity server was looking in the wrong path).

Alarm Viewer
incorrectly displays
alarms/events for
points that the role
restricts (routing)

When client-side routing was enabled, the Alarm Viewer and the Event Viewer were
displaying some alarms or events which should have not been shown to an operator who
was restricted from viewing specific points.

VEL-3382

VEL-3402

This issue has been fixed.

This issue has been fixed.

This issue has been fixed.

VEL-3406

Clicking on a
In certain situations, clicking on a plotted custom link in Graphics opened a window which
plotted Custom link displayed only a close button (the X normally appearing in the upper-right corner of a
displays just the
window).
"X" for a window
This issue has been fixed.

VEL-3416

UDF AutoSequential
Duplicated on
different
workstation

In certain situations where operators on different workstations were trying to add a new
person in Enrollment Manager at exactly the same time and the person information included
an auto-sequential user-defined field, a deadlock error would occur and only one of the
operators could save their new person.
This issue has been fixed by retrying up to three times when a deadlock occurs, and if
necessary displaying a message dialog that states:
Deadlock occurred while obtaining next AutoSequential number.
Please cancel and try again later.

VEL-3419

VEL-3425

VEL-3429

Automatic DeActivation or
Activation of
Credentials works
intermittently

When credentials were scheduled to be automatically activated or deactivated on a
particular day, the credentials which did not have a specified access function or control
function were not being processed.

Event Viewer error
when switching
between filters

In the Event Viewer, an error sometimes occurred when you tried to change the filter.

SDServer takes
too long to cache 2
million alarms on
startup

On a system with a very large number of alarms (such as 2 million), the Velocity Server
would take a long time to load because it was caching all the alarms. (On a computer which
had only 2 GB of RAM, the caching could take hours or might never finish.)

This issue has been fixed.

This issue has been fixed.

This issue has been fixed by changing how an internal array is populated.
NOTE: During a restart of the Velocity Server, clients will still receive the message “Velocity
was unable to locate the Velocity Server” until the alarm caching has finished.

VEL-3437

Velocity 3.5 SP1
After a Data installation (where a separate computer is used for Velocity’s SQL database) of
Data installation
Velocity 3.5 SP1, a log file in a temporary directory had a version number of 3.1.
log file still
references Velocity This issue has been fixed.
3.1 in filename

VEL-3438

Encountered
"Failure while
Attaching model
database" error
during German
Installation

While attempting to install Velocity on a computer with the German language Windows
operating system, an error occurred while trying to attach to the SQL database, because the
installer program was expecting the returned information to be in English.
This issue has been fixed by using a language-independent way of testing whether the
database is successfully attached.
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VEL-3451

Allow operator
override of installer
admin check

To successfully install Velocity on a computer which is part of an Active Directory domain,
you must be a member of the Domain Administrator user group. The Velocity Installer
checks whether you have the necessary privilege, and if it doesn’t think you do, displays a
message dialog stating:
Your Windows profile may not have sufficient privileges to install this software. It is
recommended that a profile that is a member of the Domain Administrator group is used.
If you continue, you may encounter an error during installation.
Do you want to continue anyway?
At a site with a complex Active Directory trust structure, the Velocity Installer might not be
able to accurately determine whether you have the necessary privileges. If you know that
you do, you can choose to continue the installation. (If not, you should cancel this
installation, log off Windows, log on to Windows with a user account which is a Domain
Administrator, and then install Velocity.)
To successfully install Velocity on a computer which is not part of a domain, you must be a
local Administrator. The Velocity Installer checks whether you have the necessary privilege,
and if it doesn’t think you do, displays a message dialog stating:
Your Windows profile may not have sufficient privileges to install this software. It is
recommended that a profile that is a member of the local administrator group is used.
If you continue, you may encounter an error during installation.
Do you want to continue anyway?
The Velocity Installer is not always able to accurately determine whether you have the
necessary privileges. If you know that you do, you can choose to continue the installation.
(If not, you should cancel this installation, log off Windows, log on to Windows with a user
account which is a local Administrator, and then install Velocity.)

VEL-3453

PSG passback
service causes
deadlocks in
SDServer and
DTServer while
trying to create/
update/ delete
command sets

A custom global passback service was causing deadlocks while trying to create, update, or
delete command sets. To help resolve this issue, the operation on the command set is
retried twice after an initial failure.

VEL-3458

Event Viewer right
click "Display
Credential" option
not working
consistently

In the Event Viewer, right-clicking on an event for a credential and selecting the Display
Credential command from the pop-up menu should display information about the person
who the credential is assigned to. Sometimes this command did not appear to be available,
or displayed information about a different person. (As described in VEL-3251, this could
happen when the Event Viewer’s content was scrolling and a different event was
accidentally selected while navigating the multi-level pop-up menu.)
This issue has been fixed.

VEL-3467

VEL-3482

When force
download a
credential to
multiple controller,
Download Monitor
shows addresses
of all the batches
to the same
controller

After you issued the Force Download command for some credentials selected in Enrollment
Manager and batch files were created to download the credentials to multiple controllers, the
Download Monitor was showing the wrong controller address for most of those batches.

Operators can
change the
credential template
linked to a
credential, even
without Application
permission

An operator whose role did not include the Application Permissions ▶ Enrollment
Manager ▶ Credentials – Link to template permission was incorrectly allowed to change
the credential template specified in the Link to drop-down list on the General page of a
credential’s Properties dialog.

This issue has been fixed.

This issue has been fixed.
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VEL-3541

“Subscript out of
range” exception
in SDServer’s
FService.Dispatch
Event.121, after
1000 client
connections

A customer discovered that their Velocity log file contained entries such as:
EXCEPTION in Class::FService.DispatchEvent.121 [9] Subscript out of range
This issue occurred after 1000 client connections.
This issue has been fixed, by making sure the underlying data array grows when a new
client connection is requested.

Known Issues
Reference ID

Summary

Description

VEL-2690

Pelco DVR
integration does not
work on Windows
Vista or Windows 7

Velocity crashes (with an “ActiveX component can’t create object” error message) when
connecting to the PELCO DX8100 DVR's cameras, using a Velocity Client on Windows
Vista or Windows 7. (The integration works as expected when using a Velocity Client on
Windows XP Professional.)
This issue is caused by Pelco not supporting Windows Vista or Windows 7. There is no
workaround.

DVR/NVR video
cannot be viewed on
Windows Server
2008

When trying to view DVR video from a Velocity Server running on Windows Server 2008,
Velocity crashes.
The workaround is to view the video from a Velocity Client (instead of the Velocity Server).
In general, the Velocity server should not be used to perform client type functions.

VEL-3027

Pelco DVR not
Starting with the Velocity 3.5 SP1 release, you cannot connect to a Pelco DVR.
functional on 3.5 SP1
(or later)

VEL-3140

Custom alarms do
not play on some
machines

On some computers running Windows Vista or later, custom alarm sounds are not heard
(either in the Customization Manager or in the Alarm Viewer). Although the exact cause of
this issue is unknown, the reason that the sounds are not heard is because the Velocity
application’s volume is set to 0% (mute) in the Windows Volume Mixer.
The workaround is to open the Windows Volume Mixer (by right-clicking on the speaker
icon in the system tray and choosing the Open Volume Mixer command from the pop-up
menu), and increase the volume for the Velocity – [Administration] application (by
dragging its slider bar up).

VEL-3268

The Enrollment
Manager’s window
sometimes opens
with a maximized
height.

Normally, the Enrollment Manager’s window opens at a standard size. But if the window
was maximized when it was closed, the next time the Enrollment Manager is opened, its
window will have a maximized height (instead of the default height).
There is no workaround for this issue.
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VEL-3287

If periods are used
as separators in a
UDF with the Type of
Date, the value is
changed to a time of
12:00:00 AM.

On an English language system, a user-defined field with the Type of Date expects the
date to be entered in the form of MM/DD/YY or MM/DD/YYYY, where forward slashes are
used to separate the 2-digit month from the 2-digit day of the month and the 2-digit or 4digit year. If you try to use periods instead of forward slashes for the separators, the value
you enter is automatically converted to a time of 12:00:00 AM.

If a computer has
only one serial port,
a serial CCTV port’s
settings cannot be
changed.

On a computer which has only one serial port, if you open the Properties dialog for a serial
CCTV port, its Port Settings fields are disabled so you cannot change their values.

An application error
occurs if no value is
specified for the Port
of a serial CCTV
port.

When creating a serial CCTV port, an application error will occur if you do not specify a
value for the required Port field.

Incorrect date/time is
shown for an alarm
video triggered on an
AD VideoEdge NVR
(using Velocity’s
legacy support)

The Recorded Alarm Video window shows an incorrect date/time stamp for an alarm video
triggered on an American Dynamics VideoEdge NVR that is using the legacy support
provided in Velocity.

Titles and column
headers are
truncated or
misplaced when a
report is exported
to an Excel
spreadsheet.

Although a report’s titles and column headers are displayed correctly in Report Manager,
they can be truncated or misplaced when the report is exported to a Microsoft Excel
spreadsheet.

Enrollment station
sometimes will not
read additional cards
when finding a
credential by MATCH
code.

The Enrollment Manager has a Tools ▶ Find Credential… command that open the Find
Credential dialog, which includes a MATCH Code option. If you use that option and then
open a credential from the Search results pane, after closing the credential and returning
to the Find Credential dialog, the enrollment station will not read another card.

After changing a
door group in the
Administration
window, the focus
switches to the
first item in the
Components pane.

When the Velocity Configuration ▶ Door Groups folder is selected in the system tree
pane of Velocity’s Administration window, the focus that indicates which item is selected in
the Components pane switches to the first item after you make a change to an existing
door group.

Update installation
fails if Velocity’s help
system is open.

If Velocity’s online help system is open during the installation of a Velocity update, the
installation will fail with a “Path/File access error” when it tries to overwrite the
Velocity.chm file (which is currently in use).

VEL-3299

VEL-3310

VEL-3356

VEL-3365

VEL-3390

VEL-3391

VEL-3397

The workaround is to enter the date using the expected forward slashed to separate the
month, day, and year.

The only workaround is to delete the existing port, then create a new port with the desired
settings.

The workaround is to try creating the port again, and make sure that you specify a value
for the Port (by selecting an entry from the Port drop-down list).

A possible workaround is to use the new American Dynamics plug-in to the Hirsch Video
Integration, which supports either an Intellex DVR or a VideoEdge NVR.

The only workaround is to manually correct the report titles and column headers in the
Excel spreadsheet.

The workaround is to close the existing Find Credential dialog and issue the
Tools ▶ Find Credential… command again.

There is no workaround for this issue.

The workaround is to close Velocity’s online help system and start the installation again.
(If you must keep the help system open, copy the Velocity.chm file to a different folder,
and double-click on the copied file to open Velocity’s help system.)
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VEL-3400

After you install a
Velocity update, the
Alarm Viewer is
sometimes initially
blank.

When Velocity’s main window is automatically opened after the successful installation of a
Velocity update, the Alarm Viewer is sometimes blank (with just a light blue background).
The workaround is to close this blank Alarm Viewer window, and then open the Alarm
Viewer again.

VEL-3413

The Cogent CSD200i Cogent replaced its model CSD200 enrollment reader by the model CSD200i, which has
an updated driver file. This updated driver file causes Velocity to generate a “No Biometric
driver is not working
Reader found” error.
for biometric
enrollment.
The workaround is to make the new CSD200i enrollment reader use the old driver file
(which was supplied with the model CSD200).

VEL-3421

Velocity cannot
communicate with a
controller using a
2-digit serial port
number.

Velocity cannot communicate with a controller that is using a 2-digit serial port number; the
port number must be a single digit.

The Searching…
dialog does not
display accurate
information when
there are many
controllers with
SNIB2 boards.

On a system where there are many controllers with SNIB2 boards, the Searching… dialog
(which appears after you click the Search button on the Properties dialog of a port with the
Network Type of TCP/IP selected and the “XNET 2 protocol” option checked) sometimes
does not display complete and accurate information.

The Customization
Manager does not
allow you to type the
characters { or } in an
event message.

In the Customization Manager, you cannot type the following special characters in the
New Value field of an Event:

VEL-3440

VEL-3473

The workaround is to change the controller’s serial port to an available port which has a
single-digit number.

There is no workaround for this issue.

• { (left curly bracket)
• } (right curly bracket)
The workaround is to type those characters in some other application, copy those
characters (to the Windows clipboard), and then paste them into the New Value field.

VEL-3485

VEL-3490

VEL-3494

VEL-3495

The Report
Manager’s Operator
Log report does not
include some events.

Some operator actions (such as performing an access function at a door) are shown in the
Event Viewer, but are not included in the Report Manager’s Operator Log report.

After switching from
an operator whose
role does not have
permission to use the
SNIB2 Import wizard,
an Administrator is
also denied access
to that wizard.

After a Velocity client is switched from an operator whose role does not include the
Application Permissions ▶ Velocity ▶ SNIB2 Import Wizard – Use permission to an
Administrator (who has full permissions), the Administrator is also denied access to the
SNIB2 Import wizard.

The Alarm Viewer
does not apply the
“Use 24 Hour Time
Format” preference
to previous alarms.

After you enable the Use 24 Hour Time Format option (on the General tab of the Velocity
Preferences dialog), when you open the Alarm Viewer new alarms are displayed using the
24-hour time format, but the previous alarms continue to be displayed using the local time
format specified in Windows.

When the Alarm
Viewer’s Force Fixed
Column Sorting
option is off, alarms
in the Acknowledged
pane sometimes are
not sorted properly.

When the Force Fixed Column Sorting option (on the Sorting tab of the Alarm Viewer
Properties dialog) is unchecked, the alarms in the Alarm Viewer’s Acknowledged pane
sometimes are not sorted in the expected order.

There is no workaround for this issue.

The workaround is to restart the Velocity client and log in using an account that has the
necessary role permission (instead of just switching operators).

There is no workaround for this issue.

The workaround is to manually refresh the Alarm Viewer.
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VEL-3496

The “Restrict alarms
and events using
Velocity Roles”
option can cause
unexpected results
when an operator
has multiple roles.

The Restrict alarms and events using Velocity Roles option (on the Advanced page of
the Velocity Settings dialog) works by excluding everything not assigned to an operator
role, rather than by including only those things assigned to an operator role. This
approach works for a single operator role, but can have unexpected results when an
operator has multiple roles.
For example, when this option is enabled on a system with two controllers, you could
create an operator role responsible for the first controller and another operator role
responsible for the second controller. If an operator is then assigned both of these roles,
you probably would expect that the operator will see the events and alarms from both
controllers, but instead the operator will not see any events or alarms from either
controller.
There is no workaround for this issue.

VEL-3498

VEL-3509

VEL-3527

The status of a new
credential with a
delayed activation
date/time might be
prematurely shown
as Active (if it was
created on a Client
in an earlier time
zone than the
Velocity Server).

On a system where a Velocity Client is in an earlier time zone than the Velocity Server, a
new user credential with a delayed activation date/time which is created on that Client
might have its status prematurely shown as Active. The credential is not actually activated
until the Velocity Server’s time reaches the specified activation time.

The value of a
controller’s Tag
option is reset to
<Never> at midnight.

When a user-defined Time Zone is specified for the Tag option on the Setup tab of a
controller’s Properties dialog, the option is reset to the default value of <Never> at
midnight.

Photo Callup feature
is limited to 10
concurrent windows

Velocity provides a Photo Callup feature (which is configured on the General tab of a
door’s Properties dialog) that displays a credential’s photo when access is attempted at a
specific door. You specify what information is displayed by the Photo Callup feature by
selecting a badge template, and you determine how long the information is displayed.
Because this feature remembered the location of the window used for each enabled door,
it was common practice for an operator to manually reposition the windows so they did not
completely overlay each other.

There is no workaround for this issue.

There is no workaround for this issue.

If too many doors are enabled with the Photo Callup feature, there can eventually be
problems caused by a lack of system resources. (This is especially true when the
information is displayed indefinitely, rather than for just a few seconds.) To reduce the
occurrence of these problems, the Photo Callup feature is now limited to 10 concurrent
windows.
For 10 or less enabled doors, the Photo Callup feature operates as before, with a window
dedicated to each door and the system remembering the position of each window. For
more than 10 enabled doors, the credential information for a door can appear in any
available window.
When all 10 Photo Callup windows are in use, a window is reused if a different credential
attempts access at one of those doors. If no window is available, the credential
information will not be displayed, and a message listing the user ID that was not displayed
will be written to the log file.
There is no workaround for this issue.
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